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What is the Iowa Electronic Death Registration System? 

The Iowa Electronic Death Registration System (EDRS) is an automated, secure web-based 
software application designed to process death records from point of initial entry and 
certification through registration and assignment of the State File Number. EDRS will expedite 
correction requests and communication on issues between funeral directors, medical certifiers 
and Vital Records. This will make records more readily available to family, the Social Security 
Administration, County Recorders, and other appropriate parties.  
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How death records flow in EDRS 
The diagram below shows the basic flow of entering a death record in EDRS.  Note: Funeral 
Directors usually initiates the record; however, if the death is non-natural, the record may be 
initiated by the Medical Examiner.  

Funeral Director selects the Certifier and saves the record.

Death Record is routed to the Work Queue of the Medical Certifier

Medical Certifier Locates death record 
in their work queue 

Reviews the Death Record and 
Enters Cause of Death Information

The death record is routed to the 
Funeral Director’s work queue

Funeral director reviews record and electronically signs

Death record is automatically numbred

Certified copies are available

Funeral Director Initiates Death Record In EDRS 
by entering personal information

Reviews information with family

Funeral director makes any necessary 
changes to the death record 
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User Roles in EDRS 

What is a user role? 
A user role controls what a user can see and do in EDRS. Roles regulate what records a user can 
access, search, and print. Each EDRS user will have a user role, in some cases more than one.  

Participants in EDRS are distinguished by their User Roles. When users register to use the 
system they are assigned roles which define what they can see and do in the system. EDRS 
contains an electronic audit trail by user role of who is accessing death records which improves 
accountability.  

All EDRS users should be aware of what role has been assigned to them and have a clear 
understanding of how their role is defined in both access and functionality in EDRS. 

Funeral Directors will have access to all records in their funeral home(s). Personal and 
demographic information will be entered electronically.  Funeral Directors will have the ability 
to initiate a death record, assign a medical certifier, request amendments and print permits. 
Reports can be run on demand with real time data.  

Funeral Home user roles 
Funeral homes user roles available:  

• Funeral Director – The Funeral Director role can create new death records; enter 
personal, demographic information, request amendments and run reports, and register 
records. 

• Funeral Home Staff – The Funeral Home role can create new death records; enter 
personal, demographic information, request amendments and run reports.    
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Becoming an EDRS User 

Requesting Access 
You will need to set up your EDRS User Account in order to work with EDRS.  An EDRS User 
account must be requested by each person who will be using EDRS.  

Do not share your account information.  All users must access the system with their own 
credentials. Accounts should not be shared. 

To request EDRS access email IVESHelpDesk@idph.iowa.gov or call (866) 309-0831. 

Logging into EDRS 

Go to the EDRS website https://idphvrs.netsmartcloud.com/NXPROD 

Enter your user ID and password and click the Login button.  

 

Enter the answser to the security question and click the OK button. 

 

mailto:IVESHelpDesk@idph.iowa.gov
https://idphvrs.netsmartcloud.com/NXPROD
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Select your location.  Note: If you only have one role/location this page will not populate. 
The next screen you see will be the home page. 

 

 

 

 

 

 

 

 

 

 
 
 

EDRS Home Page 
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EDRS work queues 

What are work queues 
EDRS work queues contain records waiting for action. When you update a record in your queue, 
it will automatically be routed to the next appropriate authority in the workflow. The funeral 
director typically initiates the death record and marks it complete. The record will then be 
routed to the queue of the physician or Medical Examiner (ME) selected in order for cause of 
death and signature to be entered. The ME or certifier will select the record from his or her 
work queue, enter the cause of death and electronically sign the record. The record is then 
electronically routed back to the funeral director’s queue to be completed and signed. Once the 
funeral director signs the record, if there are no overridden fields it will be assigned a state file 
number.  

Locating the work queues 
The Work Queues are located on the EDRS home screen. This is a list of the various queues 
assigned to your role in the system.  

The Funeral Director has the following work queues available:  

Cremation Permit - Complete 
Cremation permits that have been signed by the ME. 

Cremation Permit – Pending 
Cremation permits waiting to be signed by the ME.  

FD Change Request – Pending 
Change requests that have not been approved. 

FD Change Request – Rejected 
Change requests that have been rejected by vital records. 

FH Demographic Pending 
Death records that have not been marked personal information complete by the funeral 
home. 

FD Ready to Sign 
Death records that the personal information has been completed and the certifier has 
not signed. 

Messages 
Internal EDRS messages received from another EDRS user. 
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Death Record Layout   

Electronic death records are organized using tabs, paragraphs and fields. Tabs are the major 
sections of a record and appear at the top of the window. Tabs are subdivided into Paragraphs, 
which are recognizable by the blue lines surrounding each paragraph. Each Paragraph contains 
individual fields.  

In the example below, the first tab is the Decedent pg. 1 Tab. This tab contains paragraphs 
relating to the decedent – Deceased, and Place of Death. Some of the fields in the Decedent 
information paragraph are first name, middle name, last name.  
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Creating a Death Record 

Creating a death record using the Electronic Death Registration System begins with the 
completion of a Death Worksheet during the informant interview. The Death Worksheet is 
available for printing in EDRS under the Blank Forms menu. 

The funeral home will login to EDRS and follow the steps below to begin a new death record.   

• Initiate a new death record in EDRS 

 Click on File menu – New Event  Death 

• Enter data into appropriate fields of death record on the following tabs 

 Decedent pg 1  

 Decedent pg 2 

 Disposition Tab 

• Designate a Medical Certifier (certifier is online) 

 Go to the Certifier Tab 

 Select Physician or Medical Examiner from the dropdown list 

 Select the medical certifier’s name from the dropdown list. 

• The partially completed record can be saved using Save Without Edits 

 Click on the File menu  Save Without Edits 

• Print a worksheet for family review 

 Click on the Requests menu  Hover over Documents  click on Funeral Home 
File Copy. 
The worksheet will open in a print preview window. Print the worksheet by 
clicking on the printer icon at the top left of the print preview window.  

• Mark demographic information complete. 

 Go to Signatures  Tab 

 Enter Y in the demographic Information Complete field. 

• Save the record.  This will route the record to the work queue of the selected 
medical certifier. 
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Decedent pg 1Tab 
The decedent pg 1 tab contains a duplicate check, identifying information on the decedent and 
place of death.  

 

The first paragraph in the record is Duplicate Check. This will check for duplicate records in 
EDRS. Enter the information and click Check for Duplicates . If EDRS does not find a 
duplicate record, the information will copied down into the death record. If there is a duplicate 
record, the message below will appear.  

 

Fields that are open for Funeral Director entry are highlighted with a red box.  
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First Name 

Enter the decedent’s first name in this field.   
 
Acceptable punctuation includes the hyphen, and/or an apostrophe.  If there are two 
or more first names, it is acceptable to put a space or a hyphen between names. 

Middle Name 

Enter the decedent’s middle name in this field 
 
Acceptable punctuation includes the hyphen, and/or an apostrophe.  If there are two 
or more middle names, it is acceptable to put a space or a hyphen between names.   

Last Name 

Enter the decedent’s last name (prior to any marriage) in this field.   
 
Acceptable punctuation includes the hyphen, and/or an apostrophe.  If there are two 
or more last names, it is acceptable to put a space or a hyphen between names.  

Suffix Select the decedent’s name suffix in this field if one has been given.   

Alias names Exist on 
the record? A Value of Y indicates at least one Alias Name event exists for the record. 

Alias First Name Enter the decedent’s alias first name in this field.   

Middle Name Enter the decedent’s alias middle name in this field.   

Last Name Enter the decedent’s alias last name in this field.   

Sex Enter the decedent's sex. Enter M for Male, F for Female, or U for Unknown. 

SSN 

Enter the decedent's SSN.  Do not enter letters, special characters or punctuation; only 
numeric values can be entered in this field.   
 
If the SSN is unknown, enter '999999999'.   

SSN Missing Reason Select the reason the SSN is missing from the drop down list. 

Date of Death 
Enter the decedent’s pronounced death date in MM/DD/YYYY format.  Where MM  
is the month (01-12), DD is the day of the month (01-31), and YYYY is the year 
including the century. 

Place of Death Select place of death where decedent died. If not listed, enter the place of death in the 
field to the right. The field turns orange. 

Hospital or Other 
Institution  

Select the facility name where the death occurred from this dropdown.  If the facility is 
not listed, enter the facility name in the next field. The field turns orange. 
 
If decedent’s home, enter the street address in the field to the right. The field turns 
orange. 

City, Town or Location 
of Death 

Select from the dropdown list. If not listed select other and enter the location in the 
field to the right. The field turns orange. 

County of Death Select from the dropdown list. If not listed select other and enter the location in the 
field to the right. The field turns orange. 

Zip Code Select the zip code of the place of death from the dropdown list.  If not listed enter the 
zip code in the field to the right. The field turns orange.  If unknown, select 99999. 

Inside City Limits? Enter Y for Yes, N for No or U for Unknown 
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Decedent pg 2 Tab 

 

US Citizen Enter Y for yes, N for no or U for unknown. 

Citizenship Country Select from the dropdown list. 

Born in US? Enter Y for yes, N for no or U for unknown. 

Country of Birth 
Select the geographic location of the decedent’s country of birth from the dropdown list. 
Complete this field only if the decedent was born outside of the United States of America 
or its territories.  

State of Birth 
Select the U.S. State or U.S. Territory of birth from the dropdown list.   
 
If the decedent was born in Canada, select the Canadian province from the dropdown list.  

Date of Birth 

Enter the decedent’s date of birth in MM/DD/YYYY format.  Where MM the month (01-
12), DD is the day of the month (01-31), and YYYY is the year including the century.  
 
If unknown, enter 99/99/9999.  If a portion of the date is unknown, enter 9s for unknown 
portion. 

Street Address Enter the street address of the decedent’s residence.   

State Select the decedent’s state of residence from the dropdown list.  
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City Select the decedent’s city of residence from the dropdown list.  If not listed select enter 
the city in the field to the right. The field will turn orange. If unknown select unknown. 

County Select the decedent’s county of residence from the dropdown list.  If not listed select 
OTHER and enter the county in the field to the right. If unknown select unknown. 

Country Select the decedent’s country of residence from the dropdown list.   

Zip Code Select the decedent’s residence zip code from the dropdown list. If unknown enter 99999. 
If not listed select OTHER and enter the zip code in the field to the right.  

In City Limits? Enter Y for yes, N for no or U for unknown.  

Marital Status Select the decedent’s marital status from the dropdown list.  

Surviving Spouse’s 
First Name 

Enter the decedent's spouse's first name in this field.  Hyphen, apostrophe and spaces are 
allowed.  

Middle Name Enter the decedent's spouse’s middle name in this field. Hyphen, apostrophe and spaces 
are allowed. 

Last Name 

Enter the decedent's spouse’s last name prior to first marriage in this field.  Hyphen, 
apostrophe and spaces are allowed.  
 
If two or more last names, it is acceptable to put a space or hyphen between names.   

Suffix Select the decedent’s spouse's legal name suffix in this field only if one has been given.  

Parental Label 
Designation for 
Printing 

Select from the dropdown list. The options listed will change the labeling of parentage on 
the death certificate. 

Parent 1 First Name Enter the decedent’s Parent 1’s first name in the first name field.  Acceptable punctuation 
includes the hyphen and/or an apostrophe.   

Middle Name Enter the decedent's parent 1's middle name in the middle name field.  Acceptable 
punctuation includes the hyphen and/or an apostrophe.   

Last Name Enter the decedent’s parent 1’s last name prior to any marriage in the last name field.  
Acceptable punctuation includes the hyphen and/or an apostrophe.   

Suffix Select the decedent’s parent 1's legal name suffix in this field only if one has been given.  

Parental Label 
Designation for 
Printing 

Select from the dropdown list. The options listed will change the labeling of parentage on 
the death certificate.  

Parent 2 First Name Enter the decedent’s Parent 2’s first name in the first name field.  Acceptable punctuation 
includes the hyphen and/or an apostrophe.   

Middle Name Enter the decedent's parent 2's middle name in the middle name field.  Acceptable 
punctuation includes the hyphen and/or an apostrophe.   

Last Name Enter the decedent’s parent 2’s last name prior to any marriage in the last name field.  
Acceptable punctuation includes the hyphen and/or an apostrophe.   

Suffix Select the decedent’s parent 2's legal name suffix in this field only if one has been given.  

 
 
 
 
 
 

 
 
 
 
 
 



16 

 
Informant First Name 

Enter the first name of the person who supplied the personal facts about the decedent 
and his/her family. 

Middle Name Enter the middle name of the person who supplied the personal facts about the decedent 
and his/her family. If the middle name is not known, leave it blank. 

Last Name 
 
Enter the last name of the person who supplied the personal facts about the decedent and 
his/her family 

Relationship to 
Decedent 

Select the relationship of the informant to the decedent.  This is the individual who is 
providing information to the Funeral Director. If the informant’s relationship to the 
decedent is not listed, select OTHER and enter the relationship in the field to the right.  

Informant Address 
Same as Decedent 
Residence Address 

Click this button if the informant's mailing address is the same as the decedent's residence 
address above. 
 
This will copy the decedent’s residence address to the informant address.  

Mailing Address Enter the primary address line of the informant’s mailing address.  

State Select the informant’s mailing address state. 

City Select the informant’s city. 

Zip Code Select the informant's mailing address zip code from the dropdown list. If unknown select 
99999, if not listed select OTHER and enter the zip code in the field to the right.  

Country Select the informant’s mailing address country from the dropdown list. 
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Decedent pg 3 Tab 
Fields that are open for Funeral Director entry are highlighted with a red box.  

 

US Armed Forces? Enter Y for yes, N for no or U for unknown. 

Education Select the decedent’s education level from the dropdown list.  

Hispanic Origin? 

Enter Y for yes, N for no or U for unknown. Multiple Hispanic origins may 
be indicated.  Hispanic Origin is not considered a race for the purposes of 
the death certificate data collection.  Race must be reported separately.  
All Hispanic Origin fields will be disabled if No is indicated. 

Mexican, Mexican American, 
Chicano (a)? 

Enter Y for yes, N for no or U for unknown. Multiple Hispanic origins may 
be indicated.  

Puerto Rican? Enter Y for yes, N for no or U for unknown. Multiple Hispanic origins may 
be indicated.    

Cuban? Enter Y for yes, N for no or U for unknown. Multiple Hispanic origins may 
be indicated.   

Other? Enter Y for yes, N for no or U for unknown. If yes, the decedent was of a 
Hispanic origin that is not previously listed.   

Other Specify 
Enter the Hispanic Origin indicated by the informant that was not 
previously listed. This item must be completed if Other 
Spanish/Hispanic/Latina (o) is indicted.  

Ethnic Missing/Unknown Reason If U for unknown was entered in Hispanic Origin. This field will open for 
entry. Make a selection from the dropdown list.  

White Check this box if informant indicated the decedent was white.  Multiple 
races may be indicated.  At least one race or unknown must be selected.   
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Black or African American Check this box if informant indicated the decedent was African 
American/black.  Multiple races may be indicated.   

American Indian or Alaskan Native Check this box if informant indicated the decedent was American Indian or 
Alaska Native.  Multiple races may be indicated.   

Specify: Enter the decedent’s American Indian or Alaska Native tribe.   

Asian Indian Check this box if informant indicated the decedent was Asian Indian.  
Multiple races may be indicated.   

Chinese Check this box if informant indicated the decedent was Chinese.  Multiple 
races may be indicated.   

Filipino Check this box if decedent was Filipino.  Multiple races may be indicated.   

Japanese Check this box if decedent was Japanese.  Multiple races may be 
indicated.   

Korean Check this box if the informant indicated the decedent was Korean.  
Multiple races may be indicated.   

Vietnamese Check this box if informant indicated the decedent was Vietnamese.   

Other Asian Check this box if the informant indicated the decedent was an Asian race 
not listed previously.  Multiple races may be indicated.   

Specify: Enter decedent’s other Asian race.   

Native Hawaiian Check this box if decedent was Native Hawaiian.  Multiple races may be 
indicated.    

Guamanian or Chamorro Check this box if decedent was Guamanian or Chamorro.  Multiple races 
may be indicated.    

Samoan Check this box if informant indicated the decedent was Samoan.  Multiple 
races may be indicated.    

Other Pacific Islander Check this box if the informant indicated that the decedent was Other 
Pacific Islander.  Multiple races may be indicated.    

Specify: Enter decedent’s other Pacific Islander race 

Other Check this box if informant indicated the decedent was another race.  
Multiple races may be indicated.   

Specify: Enter decedent’s other race.   

Sought, but Unknown 
Check this box if informant does not know the decedent’s race.  If 
Decedent’s Race Unknown check box is indicated, all other race fields will 
be unavailable 

Not Obtainable Check this box if the decedent’s race is not obtainable. 
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Refused Check this box if informant refused to supply decedent’s race.  

Usual Occupation  

Enter the decedent’s usual occupation.  This is not necessarily the decedent’s last 
occupation.  "Usual occupation" is the kind of work the decedent did during most 
of his or her working life, such as claims adjuster, farmhand, coal miner, janitor, 
store manager, college professor, or civil engineer.  DO NOT ENTER "RETIRED."  
Do not use acronyms (e.g., C. P. A., R. N.) If the decedent was a homemaker at 
the time of death but had worked outside the household during most of his/her 
working life, enter that occupation.  If the decedent was a homemaker during 
most of his/her working life, and never worked outside the household, enter 
"Homemaker." Enter "Student" if the decedent was a student at the time of 
death and was never regularly employed or employed full time during his/her 
working life. If unemployable due to physical or mental condition, enter "Never 
worked." 

Kind of Business or Industry 

Enter the kind of business or industry that the occupation listed is related to, 
such as insurance, farming, coal mining, hardware store, retail clothing, 
university, or state government.  DO NOT ENTER FIRM OR ORGANIZATIONAL 
NAMES.  Do not use acronyms (e.g., H. M. O.).  If the decedent was a homemaker 
during his/her working life, and "Homemaker" is entered as the decedent's usual 
occupation in item 32, enter "Own home" or "someone else's home," whichever 
is appropriate.  If the decedent was a student at the time of death and "Student" 
is entered as the decedent's occupation, enter the type of school, such as high 
school or college, for the kind of business or industry.  If unemployable due to 
physical or mental condition, enter: "Never Worked." 
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Disposition Tab 
Fields that are open for Funeral Director entry are highlighted with a red box.  

 

Method of Disposition 

Select method of disposition of the decedent's body. If the method is not 
listed select OTHER and enter in the field to the right. Based on the 
disposition selected, other fields in the record will be required and open 
for entry.   
If Cremation is selected, a REMINDER message will appear stating the 
date of death indicator and the time indicator must be entered on the 
cause of death tab for the permit to be issued.  Click OK to close the 
message.   

Medical Examiner Assigned If a cremation, select the Medical Examiner from the dropdown list. 

Email Enter the Medical Examiner’s email. 

Crematory 
If a cremation, select the Crematory from the dropdown list, if not listed 
enter the name in the field to the right.  The field will turn orange.  
The state and city fields will also open for entry 

Cemetery, or Final Disposition Select location from the dropdown list. If not listed, enter in the field to 
the right.  The field will turn orange. 

For Burial Permit – Name of 
Person Taking the Body 

These fields will only be open if Donation, Private Burial or Removal from 
State are selected as Method of Disposition. 

Funeral Home Name Funeral Home handling the disposition. 
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Address Enter the address of the disposition location. 

State Select the funeral home state.  

City Select the funeral home city. 

Zip Code Select the zip code from the dropdown list. If not listed, enter the zip 
code in the field to the right. The field will turn orange.   

Funeral Director Name Select the funeral director’s name from the dropdown list. If not listed, 
enter the name in the field to the right. The field will turn orange. 

License Number Enter the Funeral Director’s License Number if not already populated.  

Phone Number Enter the funeral director’s Phone Number.  

Email Enter the funeral director’s email address.  

Certifier Tab 
Fields that are open for Funeral Director entry are highlighted with a red box.  

 

Certifier Type Select the certifier type from the dropdown. 

Assign to Medical Certifier Select the medical certifier’s name from the dropdown.  
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Cause of Death Tab  
The only fields open on the Cause of Death tab are Date/Time of Death fields when cremation is 
selected.  

 

Date of Death Indicator Select from the dropdown list. 

Time of Death Enter the time of death in military format. For example, enter 13:00 for 
1:00 pm  

Time of Death Indicator Select from the dropdown list.  

Signatures Tab 
Fields that are open for Funeral Director entry are highlighted with a red box.  
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Demographic Information 
Complete? 

If you have entered all demographic information in this decedent's 
record, enter Y in this box indicating that the Personal Information is now 
Complete. 

FD Signed? 

Enter a Y to indicate that the death record is certified as complete and 
accurate by the Funeral Director or the person acting as such.  
 
A Y may not be entered here until the medical information has been 
completed and signed. 
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Searching for death records 

EDRS has full function searching capabilities. Select the Search menu and click on the type of 
records to be searched, e.g., Death. Once the type of record is selected the following search 
screen will appear: 

 

On the Search screen, note that there are two tabs –Search Criteria and Search Results.  

 

The Search tab, shown below, is where search criteria are entered.  
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Any combination of the fields may be searched. To search by name for example, you can enter 
any combination of first name and last name. Once the criteria are entered, click the Search 
button at the top right of the screen. The results tab will appear with all records that meet the 
criteria entered. The number of records found will appear at the bottom of the screen. If there 
are no records found, a message will appear at the bottom of the screen.  

 

If the search does not produce the record desired, try entering less information in the search 
criteria to expand the search. For example, instead of John Doe, enter Doe to retrieve all 
records with the last name of Doe. NOTE: The system will only return the first 500 entries of a 
search. Should more than 100 records meet the search criteria, it is best to refine the criteria to 
get fewer records returned. One way to refine the search results is to enter more information. 
For example, enter John Doe with date of birth 09/01/2020.  

To search again, click on the search criteria tab to go back to the search criteria screen and 
enter additional information. To begin a new search, click Clear button at the top right of the 
results window and enter new criteria.  

 

The results window may be sorted by any of the fields. Click once on the field name at the top 
of the column you wish to sort by. Only one field may be sorted at a time. Click on the field 
name again to sort in the field in descending order. 
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Using Wildcards in a search 
Wildcards are characters that expand your searching capabilities. These may be used to search 
many of the fields in EDRS. One of the most common wildcards is the % sign. For example, to 
find all last names that begin with S enter S% in the last name field. Entering MC% in the last 
name and J% in the first name field will give you all records with a last name beginning with the 
characters MC and first names that begin with J.  

 

Using Parameters in a search 
Parameter searches will find records that meet comparison criteria. The characters in the 
following table may be used. NULL can also be entered directly in a field.  

> Greater than 

< Less than 

= Equal can be combined with the greater than, less than (>= or <=)  

NULL Empty – nothing entered in the field.   

(X=Z) Between X and Z  including X and Z. 
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Cert Request Tab 
The cert request tab will allow the funeral home to electronically request certified copies from 
the county registrar. 

Pickup or Mail Certificates Select how the funeral home would like to receive the certified copies 
from the dropdown list. 

Copy the address from: Select from the dropdown list, which address should be used on the 
application created for the country register. 

Email Address Enter the email address  

Phone Number  Enter the phone number  

County to process certified 
copies Select the county to request the certified copies from 

 
Click the button to create the application for certified copies. 
The window below will appear to select the type of copies requested and 
the fees. 

 

Select the fee type and enter the number of copies desired.  Click Request Certificates to send 
order the county recorder.  

Print your Order Receipt.  This receipt provides you with the Application number. 
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Forms/Documents 

Blank forms 
EDRS provides blank forms to assist the user in performing their work. Blank forms are available 
in the Blank Forms menu of the EDRS home screen seen below. To print a blank form, select it 
from the list. The following blank forms are available for printing:  

 

Populated documents 
Completed or partially completed documents are available for printing in EDRS. Completed or 
partially completed documents can be printed from the Requests menu, when a death record is 
open in EDRS. 

In the example below, a death record was searched and displayed. Once the record is 
displayed, click on the Requests menu and choose the appropriate documents to print. 

 

After selecting the desired document, it will open in a print preview window. To print the 
document use the printer icon at the top left of the window.  
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Printing Permits 

Cremation Permits 
Cremation permits must be signed by the medical examiner’s office.  Funeral homes will be able to track 
the permits using their work queues.  The Cremation Permits pending work queue will show death 
records with cremation permits requested from the ME.  After the ME signs the permit, it will be moved 
automatically to the Cremation Permits complete work queue. This is where the funeral home can 
access the death record and print the Cremation Permit.  

 Open the Cremation Permit Completed work queue 
 Open the desired record 
 Select  Documents  Cremation Permit 

 

  

IMAGE WILL BE ADDED 
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Amending a death record  

Funeral Homes can request an amendment to a registered death record. The Funeral Home will 
complete an amendment request and submit it to Vital Records approval.  

Requesting an amendment 
• Search for the record 

• Open the record 

 Click on the File Menu 

 Select New Event – Change Request 

 
New pop-up asking if you want to leave the site – Select Leave 

 
• Change Request Window Opens 

 Select the type of Modification the dropdown list 

 Select the Documentation used from the dropdown list. The only selection 
available is Error – Typo. 

 Save the change request  

• Enter the item to be corrected 

 Click the Add Item for Correction button  

 Selet the item to be corrected from the dropdown list  

 Enter the Corrected Value  

 Click the Save Item to be Corrected button 

 If more than one item needs to be corrected, click the Add Item for Correction 
button again to correct another item.  
The grid at the bottom of the window will display all fields with corrections 
requested.  
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In the example below, two corrections are requested – Middle Name and Zip code.  

 

 

• Submit the change request to Vital Records 

 Click on Approval Tab – located at the top of the screen. 

On the Approval Tab enter Y in Initial Entry Completed and Ready to Approve 

 
 Enter any optional notes if needed 

 Save the record.  This will route the request to Vital Records for approval. 
The record will appear in the FD Change Request Pending work queue. 
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Rejected amendments 
If the amendment request is rejected by Vital Records, it will appear in the FD Change Request 
Rejected work queue.  

To review the rejected amendment request: 

• Check the Work Queue for record(s) that have been rejected by Vital Records 

 Click on the Work Queue menu 

 Select FD Change Request Rejected 

 Identify and select a record to review 

 In the Work Queue window, highlight the name of the appropriate record 

 Click on Display or double click to open the record 

• Review Notes for reason rejected 

 On the Approval tab review Reason/Notes for Rejection 

 Make needed changes to the request 

• Resubmit the request 

 On the Approval Tab enter Y in Initial Entry Completed and Ready to Approve 

 Enter any optional notes if needed 

 Save the record.  This will route the request back to Vital Records for 
approval. The record will appear in the FD Change Request Pending work queue. 
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Death reports 

Accessing Reports 
Reports are stored in the Report Center for easy access by all authorized users. The Report 
Center contains a variety of reports. To access the Report Center: 

• Click on the Batch menu 

• Select Reports 

 
 

Running Reports 
Select the desired report from the available reports list on the left side of the window. The 
parameters for the report will appear on the right side of the window. Some of the parameters 
will have default values and can be changed. Some parameters cannot be changed; these will 
display “the field is protected” in the select parameters box. 

Selecting parameters is not required, is recommended. Using parameters will speed up running 
the report and give better results.  

In the above example, the Completed Records report is selected. The parameters are Funeral 
Home Name and Date of Death between 01/01/2020 and 11/30/2020.  

Parameters can be typed or selected, to select parameters click on the lookup button.  To 
preview the report, click the Preview / Test Run button at the bottom of the report center. To 
send the report directly to a printer, click the Print / Update button. It is STRONGLY 
recommended to Preview the report before printing. Some of the reports can be hundreds of 
pages long.  Printing the report sends it directly to the printer with no preview.  

If there are several pages in the report, use the page navigation arrows at the bottom of the 
window seen below to advance the page.  
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Data Entry Exception Messages  

EDRS contains edits that will automatically display error messages on the screen when an 
incorrect, questionable or erroneous entry is made. The error message will let you know what 
field or fields are in error.  

 

 

 

 

 

 

 

There are three types of messages with varying degrees of importance. The action buttons 
available will vary with the different types of messages.  

The first type of message must be fixed, for example, leaving a required field blank.  

The only options available are: 

• Re-key the field – Returns the user to the field for re-entry. On Re-key of date fields, hit 
delete to clear the field before re-entering.  

• Skip for Now – will take the cursor to the next field for entry leaving this field blank. The 
system will not allow you to complete a record with skipped fields. The background 
color of the skipped field will change to dark green.  

 

The other types of messages are warnings of an outlying value. For example, the condition failure to 
thrive usually develops as a complication of another more specific condition. EDRS will edit this 
condition when reported as the underlying cause of death. This edit checks to ensure the proper 
underlying cause of death is entered.  If the certifier determines this underlying cause is correct, select 
‘Queried and Verified’.  

In addition to Re-Key and Skip, the other option available is: 

• Queried and Verified – will indicate that the information you entered was correct, e.g., 
the decedent is 15 years old with a high school diploma.  

Error 
 

Action 
Button
s 
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The option for ‘Override and Query Field’ is not available in EDRS. 

Some of the warnings will also have the bypass buttons available: 

 

• Queried and Verified – will indicate that you have verified the value. 

• Queried – Not Verified – will indicate that you did not verify the field in error. The 
system will not allow you to certify a record until the field in error has either been 
verified or corrected.                                                 

          

 

 

 

 

 

  



  37   

Security 

Changing Password 
The first time you login to EDRS you will be asked to change your password. Enter the 
temporary password received from IDPH as the old password and enter the desired new 
password in the New Password and Confirm fields. 

To change the password at any time: 

• Administration  Change Password 

• Enter the current password in the old password field 

• Enter the new Password 

• Enter the new password again in the confirm new password field 

• Click the change button 

 

The next login you will use the new password. 

Forgotten Password 
To reset a forgotten password 

• Click Forgot My Password link below the Login button 

• Enter your User ID 

• Click Reset Password 

A password reset link will be sent to the email address configured with your account.  
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Security Questions 
A security question will appear after entering the password each time you login to EDRS.  The 
first time you login, a question will appear that was created by IDPH for you.  The answer to the 
question was contained with your temporary password.  You will need to change this security 
question/answer as well as create 2 new questions and answers.   

To change security questions: 

• Search for existing security questions                                 

 Click on Tools> Search>Security question 

 Select Security Question 

 Enter either the question, your login name or ALL 

 

 

 

 

 Click Search 

• Open the desired question from the results 

 Select the question from the results 

 Click on Display or double click to open the question 

• Change the question and the answer to the question               

 Delete the text in the question field 

 Enter a new question 

 Delete the answer to the question 

 Enter the answer to the new question 

 Save the question  

 Close the window 

To create a new security question and answer 

•  Create a new question 

 Click on the File Menu 

 Select New  Security Question                                             

 Enter the new question in the Question Field 

 Enter the answer in the Answer to Question field.  

 Save the question  

 Close the window 
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In the example below, “My Dog’s Name?” was entered in the Question field.  “Frisky” was 
entered in the Answer to the Question field.  Each time this question pops up “Frisky” will have 
to be entered.  

 

 

 

  



40 

 

Keyboard Shortcuts for Vital Records System 

New Record 

 

Death 
 

Ctrl – D  

Move to next field Tab key 

Move to next Tab  Ctrl - Tab Key 

Move to previous field Shift - Tab Key 

Move to previous Tab  Shift - Ctrl - Tab Key 

Move to first field of next section Ctrl - P 

Clear a field – clears field where 
cursor is 

Ctrl - Z 

Enter today’s date in a date field T 

Select a checkbox  
Hit spacebar or click – this places a checkmark OR 

clears a checkmark  

Close Window Alt - F4 

Save Ctrl – S 

 


